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Introduction

This installation procedure is the basis for all Wonderware products used on a Remote Desktop Session Host (Terminal Server), for
example, InTouch View for System Platform (Managed Applications), InTouch (Standalone Applications), Historian Client, and the IDE
(used by multiple developers via Remote Desktop Connections).

This Tech Note describes the installation steps for the Remote Desktop Services Server Role of Windows 2008 Server R2, formerly
known as Terminal Services. It is assumed that the operating system has already been installed and Microsoft updates applied.

Application Versions

e InTouch 10.1 and later

¢ Microsoft Server 2008 R2

New Terminology

With Release 2 of Windows 2008 Server the Terminology of Terminal Services has changed. The following table shows the new
nomenclature:

Old Terminology Terminology of Windows 2008 Server R2
Terminal Services (TS) Remote Desktop Services (RDS)

Terminal Server Remote Desktop Session Host

Terminal Server Licensing Remote Desktop Licensing (RD-Licensing)

Terminal Services Web Access (TS Web Access) Remote Desktop Web Access

Terminal Services Gateway (TS Gateway) Remote Desktop Gateway

Terminal Services Session Broker (TS Session Broker) Remote Desktop Session Broker

Installation

You install and configure Roles using the Server Manager.

Adding the Remote Desktop Services Server Role
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To add Server Roles

Installing and Configuring Remote Desktop Services for InTouch® Standalone Applications

1. Click Start > Administrative Tools > Server Manager.
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Ficure 1: OPEN SERVER MANAGER
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2. Right-click Roles, then click Add Roles (Figure 2 below).
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Ficure 2: Abb RoLEs

3. Click Next.
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Ficure 3: Abb RoLEs WIizaArRD

4. Check Remote Desktop Services on the list to install and activate this role.

5. Click Next.
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Ficure 4: AcTivaTE REMOTE DESkTOP SERVICES ROLE

Selecting the Correct Role Services

Each Server Role includes several Role Services. For a simple environment the following components are required:
« Remote Desktop Session Host (formally Terminal Server)
« Remote Desktop Licensing

For Remote Desktop Web Access (formally Terminal Server Web Access), Web Server (11S) is necessary. Selecting this Role Service
causes the default installation of a Web Server (Figure 5 below)
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Add Roles Wirard |
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Ficure 5: Abb WEB SERVER SERVICES

Note: Additional Role Services can also be added at any time.

Authentication Mode

Two Authentication methods are available. In this example the second option is selected, because Network Level Authentication is
supported since RDP 6.0. That means clients with older operating systems. For example Windows XP SP1 would not have access to the
Remote Desktop Session Host.
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Add Roles Wizard x|
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Ficure 6: Do NoTt ReEQUIRE NETWORK LEVEL AUTHENTICATION

Licensing Mode

Microsoft offers a 120-Day Demo License. This license is used for this Tech Note. The original license can be added afterwards, so select
the Configure later option. For more information about licensing contact Microsoft.
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Ficure 7: CoNFIGURE LICENSE LATER

Add User Groups

The users and user groups are added here. These are the people who will have access to the Remote Desktop Session Host. They are
added to the local Remote Desktop Users Group.
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Add Roles Wizard

ﬁ. Select User Groups Allowed Access To This RD Session Host Server

Before You Begin
Server Roles

Add the users or user groups that can connect to this RE Session Host server, These users and user groups
will be added to the local Remote Deskiop Users group, The Admnistratons group is added by default and
cannot be removed.

Users or User Groups:

h‘-“m'ﬁtram

B, stephanich (ROS2008R2\Stephaniek) _I

More about the Remots Deskiop Lisers group

crevos [[Tht> ] i

Ficure 8: ConNFIGURING User GRours FOR REMOTE DeskToP Users GRour

Configuring the Client Experience

Keep the default settings (Figure 9 below)
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l Add Roles Wizard x|
ﬁ; Configure Client Experience
Bafore You Begn You can configure the RD Session Host server so that users connecting to a remote desktop session can use
e Rod functionality smiar to that provided by Windows 7.
Remote Deskiop Services
/v, Providing this funciionality requires additional system and bandwidth resources and may affect the
Role Services scalability of the RD Session Host server,
Application Compatiiity
Authentication Mathod Salact the functionality that you want to provide. Additional functionality can be configured by using the
Remote Desktop Session Host Configuration tool.
Licensing Made
Lser Grougs (i) Selecting sudio and videa playback or desktop compasitionwill installthe Desktop Experience

feature onthe RD Sesslon Host server.

Chenl ExparssncE
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Role Services ™ Audio recording redirection
Confirmation ™ Desktop compoation (provides the user nterface slements of Windows Aero)
Progress
Resuts G} If aselection is dimmed, a Group Policy setting is currently being applied to the computer that:

prevents that functionality from being configured. Far more information, see Group Policy
Settings and Configuring the Client Experience.

li
More about configuning the dient experience

-:Pm-lmsl Mext > I Trestall Cancel

Ficure 9: LEAVE THE DEFAULT SETTINGS
Remote Desktop Licensing Configuration

Note: This option does not apply to Windows 2008 Server R2.
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Add Roles Wizard B x|
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Ficure 10: RD Licensing CONFGURATION

Web Server (11S and its Role Services)

For Remote Desktop Web Access the Web Server Role must be installed. Keep the default Role Services (Figure 11 below).
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Ficure 11: LiceNsSING

Now the installation begins (Figure 12 below).

I Add Roles Wizard

ﬁ. Installation Progress

Before You Begin The following roles, role services, or features are being installed:

Server Roles
Remate Desktop Services
Role Services
Apphcation Compatibiity
Authentication Method
Licensing Mode
User Groups
Client Experiance
RO Licensing Configuration
Web Server (I5)
Role Services
Confirmation

[ Proges |

Remote Desktop Services
Web Server (I1S)
Remote Server Administration Tools

Ficure 12: BEGIN THE INSTALLATION

Restarting the System

Adding the Server Roles requires a restart (Figures 13 and 14 below).
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Add Roles Wizard

=
ﬁi Installation Results

Before You Beg
Begn COne or more of the following roles, role services, or features require you to restart:
Server Roles
/¥ 3warming messages below
Remote Deskton SErices &
Role Sarvioes ~ Remote Desktop Services /1, Restart Pending
Application Compatibdity A You must restart this server to finsh the installabon process.
Authentication Method
| Web Server (TIS) /1. Restart Pending
Licensing Mode
LI You must restart this server to finish the installabon process,
Liser Groups
Chent Experience *' Remote Server Administration Tools /1, Restart Pending
RO Lezenising Configuraton A0 You must restart this server to finish the installation process.
Web Server [TI5)
Role Services
Confirmation
Progress

Ficure 13: ResTART AFTER INSTALLING THE ROLES

Add Roles Wizard

@ Do you want to restart now?

This server must be restarted to finish the installation
process, You cannot add or remove other roles, role services,
or features until the server is restarted.

Yes

Mo

Ficure 14: PrROMPT FOR RESTART
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Ficure 15: RemoTE DESkTOP SERVICES RESTART

Remote Desktop Services are NOT started automatically by default (Figure 16 below).
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Ficure 16: RemoTE DESkTOP SERVICES IS SET TO MANUAL BY DEFAULT

Enable Remote Access on the Server
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Remote Access must be enabled. When you start the Server Manager, the Server Summary is displayed.

1. Open Server Manager, then click Configure Remote Desktop.

2. To ensure that clients with RDP Versions earlier than 6.0 will have access to the server, click the second option in the Remote
Desktop area (Figure 17 below).

Server Manager (RDS2008R.2)

3 x|
h_ Get an over server rodes and features,
Cl:ll‘u.i-rhl-nul Hardware | Advanced Remote ]
i~ Remote Assistance 1 .
~ Server Summary ﬂ Server Summary Help
r.-"-l;'u b Ra i - R 'I"l"l THrLbE
~ Computer Infor (& Change System Properties
Full Computer Mar
Workgroup: |
Local Area Conne
- [~ Remaote Deskiop
Remote Desktop:
s Click: an option, and then specify who can connect, f neaded.
Server Manager F
Management: " Don't allow connections to this comp
Product ID: =
F Do not shown
Deskiop with Nﬁwu‘k Lm.rel Authertication jmone secure)
~ Security Inforn el Uan | i Go to Windows Frewal
Windows Frewall: | & Configure Lipdates
*+ Check for New Roles
S cm: P Chries | oK I Cancel | Al | F Run Security Configuration Wizard
Last chedked for L. . Vi Configure IEESC
Last instaled updates: 5/6/2011 3:05 AM
IE Enhanced Seaurity Configuration Off for Administrators
(ESC): Off for Users

Ficure 17: ALLow ConNNEcTIONS FROM ANY VERsION oF REMOTE DEskTOP

Network Discovery

By default, the node is not visible to other machines in the network environment. You change this setting in the Network and Sharing
Center.

1. In the Control Panel select Network and Internet:
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EF Control Panel

‘CD I3 + control Panel ~

- m|5ea-mr.onmpm

Adjust your computer's settings

System and Security
1 i Review your computer's status
Check firewall status

) view event logs

Network and Internet
View network status and tasks

Yiew devices and printers
= -] add a device
rams
= pstall a program
e —==o urn Windows features on or off
AutologOnliser
Documents

8,
Ay,
“

View by: Category ™

User Accounts

iy Add or remove user accounts

Appearance

Change desktop badkground
Adjust screen resolution

Clock, Language, and Region
Change keyboards or other input methods

Change desplay language
Set the time and date

Ease of Access

Let Windows suggest settings
Optirize visual display

Ficure 18: EnaBLE NETWORK VISIBILITY

2. Click Changed advanced sharing settings.
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EIE_ Hetwork and Sharing Center
e s
Ql\ )v v+ = Control Panel = Metwork and Int]
Control Panel Home View yol
Change adapter settings
ange advanced sharing settings

View yaour
-

Ficure 19: CHANGE ADVANCED SETTINGS

3. Change the Network Discovery settings to match Figure 20 (below) and click Save Changes.
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=, Advanced sharing settings

mcH ~ Network and Sharing Center = Advanced sharing settings - mlﬁaﬁd‘lm'ltdpﬂ'ﬂ

Change sharing options for different network profiles
Windows reates a separate network profile for each network you use. You can dhoose spedfic options for each profile.
Home or Wark j

A
Metwork discovery

Public (current profile)

other Ork, Comouihe [ O treork OF

* Turn on network discovery

" Turn off network discovery

File and printer sharing

When file and printer sharing is on, files and printers that you have shared from this computer can be
accessed by people on the network.

T o e e 2>

" Turn off fle and printer sharing

Public folder sharing

When Public folder sharing is on, people on the network, nduding homegroup members, can acoess fles in

the Pubbc folders. ¥
= Turn an sharing 5o anyone with network access can read and write ﬁmhw@

" Turn off Publc folder sharing (people logged on to this computer can still acoess these folders)

Password protected sharing

@mww|

— e

B JEE

Ficure 20: CHANGING SHARING OPTIONS

4. Make sure you have a viable Network connection.
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=10 x|
6{:).;1-‘} - Controi Panel = Network and Intemet = Network and Sharis Center » 883 [[search Controipanel ﬂ
Control Panel Home View your basic nebwork infermation and set up connections
) =3 See full map
Change advanced sharng sattngs ROSI008R2 corp.com Inkarnat
(This computer)
View your acthve networks Connect or disconnect
COrp.Com ACCEsS bype: Internet
Fublic network Connections: | Local Area Connection
Change your networiing setbings
i Setup anew connachon o network
= Satupa wirsless, broadhand, dial-up, ad hac, or VPN connection; of satup a router of Aooess pont.
-5. Connect to a nebwork
Connect or reconnect to a wireless, wired, dial-up, or WP network connecton,
i'_'f': Troubleshoot problems
" Diagnose and repar neteork problems, or get troubleshooting informaton.

Ficure 21: ViaBLE NETwWorRk CONNECTION

Show Hidden Files and Folders

Using Windows Explorer, show hidden files, folders and drives.

* In Windows Explorer, click Organize > Folder and Search Options > Folder Options > View tab (Figure 22 below).
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x|

l\_)l\_) |ﬂ * Libraries - General View |Sem:h|

Organize *  Mew library ~ Folder views
You can apply the view (such as Detads or lcons) that
¢ Cuk [z22]  you ane using for this folder to all folders of this type.
Copy : eriyio ok Reset Folders |
£l Paste
[rda
Reda Advanced seftings:
Selact all [#] Display file size information in folder tips ZI
[ Display the full path in the tithe bar (Cassic theme only)
[Ciayout » Hidden files and folders
Folder and search options D Dont show hidden F“E-'S. FU'dEI'S. or drives
[0 Show hidden files, folders, and drives
75 Delete [¥] Hide empty drives in the Computer folder
Remane [¥] Hide extensions for known file types
Remove properties [#] Hide protected operating system files (Recommended)
Properties [0 Lsunch folder windows in & ssparate process
M Eaed [ TUTTOR o0 UL P S e Pp——

Ficure 22: SHow HIipbeN FiLEs, FoLbERS, AND DRIVES

Disable UAC

For the installation of Wonderware Software, UAC (User Access Control) should be disabled. More details are described in Technote 733
Disabling UAC for Wonderware® Product Support.

S. Bruder, M. Aguinaldo

Tech Notes are published occasionally by Wonderware Technical Support. Publisher: Invensys Systems, Inc., 26561 Rancho Parkway South, Lake Forest, CA 92630. There is also
technical information on our software products at \Wonderware Technical Support.

For technical support questions, send an e-mail to wwsupport@invensys.com.
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©2011 Invensys Systems, Inc. All rights reserved. No part of the material protected by this copyright may be reproduced or utilized in any form or by any means, electronic or
mechanical, including photocopying, recording, broadcasting, or by anyinformation storage and retrieval system, without permission in writing from Invensys Systems, Inc.
Terms of Use.

file:///C|/inetpub/wwwroot/t002563/t002563.htm[11/1/2011 9:01:20 AM]


file:///C|/inetpub/wwwroot/t002563/t002508.htm
file:///C|/inetpub/wwwroot/t002563/t002508.htm
https://wdn.wonderware.com/sites/WDN/Pages/Tech_Support/TechSupport.aspx
mailto:mailto:wwsupport@invensys.com
file:///C|/inetpub/wwwroot/t002563/T000792.htm

	Local Disk
	Installing and Configuring Remote Desktop Services for InTouch® Standalone Applications


